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Overview 

Apple Mail is an email program that comes inbuilt with Apple Inc.'s Mac OS X. It is also called as 

Mail.app. Mail.app supports MS Exchange Server 2007 by use of Exchange Web Services. Apple Mail is 

somewhat similar to MS Outlook, but has lesser features. To view Apple mails into MS Outlook 2011, the 

mail file must be converted to .rge file. RGE file is supported by MS Outlook for Mac. 

 

Stellar Apple Mail to Outlook 2011 Converter converts Apple Mail to .rge files. After conversion, user 

can access the .rge file in MS Outlook 2011 for Mac. 

What's New? 

 Supports preview of converted mails. 

Key Features 

 Converts Apple Mail files to .rge files. 

 User-friendly and secure software. 

 Folder hierarchy is maintained. 

 Supports MS Outlook 2011. 

 Simple User Interface. 

 

 

 

 
 

 

 

 

 

 



 

 

Installation Procedure 

Before installing the software, ensure that your system meets minimum system requirements. 

Minimum System Requirements 

 Processor: Mac-Intel 

 Operating System: Mac OS X 10.7 or above 

 Memory: 1 GB RAM 

 Hard Disk: 100 MB of free space 

Steps to install Stellar Apple Mail to Outlook 2011 Converter 

 To install Stellar Apple Mail to Outlook 2011 Converter, follow these steps: 

 

 Unpack Stellar Apple Mail to Outlook 2011 Converter.dmg.zip file. 

 After decompressing it, double click .dmg file. This will mount a virtual volume - Stellar Apple Mail 

to Outlook 2011 Converter. 

 Double-click Stellar Apple Mail to Outlook 2011 Converter volume to open  Stellar Apple Mail to 

Outlook 2011 Converter window.  

 Drag Stellar Apple Mail to Outlook 2011 Converter file to Applications folder. 

 To launch the software, double click on Stellar Apple Mail to Outlook 2011 Converter file in 

Applications folder. 

 This displays License Agreement. If user accepts the License Agreement, then the software is 

launched; otherwise, it quits. 

 

To remove the software, drag and drop the Stellar Apple Mail to Outlook 2011 Converter file from 

Applications folder to trash. 

 
 

 

 



 

Order and Register 

Order Stellar Apple Mail to Outlook 2011 Converter 

 

The software can be purchased online. For price details and to place an order, click here. 

Once the order is confirmed, a pre-paid registration key will be sent through e-mail, which would be 
required to register the software. 

 

Register Stellar Apple Mail to Outlook 2011 Converter 

 

To Register Stellar Apple Mail to Outlook 2011 Converter: 

 

1. Click Register option from the Tools menu or on the toolbar, click Register. 

2. In the Registration window that pops up, do one of the following: 

If you have purchased the product and received registration key, 

 Select 'I have a key to register the product'. Click OK. 

 Enter the Registration key and click OK, to complete the process. 

If you have to purchase the product, 

 Select 'I don't have a key to register the product'. Click OK, to go to the order web page, where 

you can order and purchase the product. 

 

 

 

 
 

http://www.stellarinfo.com/email-tools/mac-mail-to-outlook-converter/buy-now.php


 

 

Stellar Support 

Our 'Technical Support' professionals will give solutions for all your queries related to 'Stellar' products.  

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click http://www.stellarinfo.com/email-tools/mac-mail-to-outlook-

converter/buy-now.php 

Chat Live with an 'Online' technician at http://www.stellarinfo.com/ 

Search in our extensive 'Knowledge Base' at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry/ 

E-mail to Stellar Support at support@stellarinfo.com 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Tollfree- Pre Sales Queries)  +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders  orders@stellarinfo.com  
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Launching the Software 

Follow any of the following methods to run Stellar Apple Mail to Outlook 2011 Converter on a Mac 

system. 

 

 Double click on Stellar Apple Mail to Outlook 2011 Converter file in Applications folder. 

 Double-click on Stellar Apple Mail to Outlook 2011 Converter desktop shortcut (if it is created). 

 Click on Stellar Apple Mail to Outlook 2011 Converter icon in the dock (if it is created). 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Main User Interface 

Stellar Apple Mail to Outlook 2011 Converter has a very simple and user friendly Graphical User 

Interface (GUI). 

 

 

 
 

Menus 

Stellar Apple Mail to Outlook 2011 Converter Menu 

About Stellar Apple Mail to Outlook 2011 
Converter 

Use this option to read information about 
Stellar Apple Mail to Outlook 2011 
Converter.  

Services 

Use this option to browse the services 
offered by the software. 

 

 

 

 



Hide Stellar Apple Mail to Outlook 2011 
Converter 

Use this option to hide the icon of this 
software on your screen. 

Hide Others 

Use this option to hide other software icons 
on your screen. 

Quit Stellar Apple Mail to Outlook 2011 
Converter 

Use this option to exit from the software. 

 

File Menu 

Open File 

Use this option to select the desired file for 
conversion. 

Save File 

Use this option to save the converted file in the 
desired location. 

 

 

 

 

Tools Menu 

Register... 

This option is enabled when you are using 
unregistered version of Stellar Apple Mail to 
Outlook 2011 Converter application. Use it to 
register your product. 

 

 

  

 

Help Menu 



 

 

Help Topics... 

Use this option to view Stellar Apple Mail to 
Outlook 2011 Converter help manual. 

Order Stellar Apple Mail to Outlook 2011 
Converter 

Use this option to buy Stellar Apple Mail to 
Outlook 2011 Converter. 

Email to Stellar Support 

Use this option to mail for support against 
any problem. 

View Support Section 

Use this option to visit support page of 
stellarinfo.com. 

Submit Enquiry 

Use this option to submit enquiry to 
stellarinfo.com. 

View Knowledgebase Articles 

Use this option to visit knowledgebase 
articles of stellarinfo.com. 
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Select and Convert Apple Mailbox 

The Apple mailbox should be opened in Stellar Apple Mail to Outlook 2011 Converter software to 

convert it. To select an apple mailbox, follow these steps: 

 

 Start the Stellar Apple Mail to Outlook 2011 Converter software application. 'Select File' dialog 

box is displayed by default. Default location for the apple mailbox is selected by default in the file 

path text box. 

     Or, 

Alternatively, click on Open button on the toolbar or click on Open File option from the File menu to 

select the mailbox to be converted. 

 

 

 

 Click Browse to select the required Apple mailbox from a different location.  

 'Open Directory' dialog box is displayed. Select the mailbox that is to be converted. Click Open button. 

 The selected file path is displayed in the 'Select File' dialog box.  

 Click on the Start button to start scanning process. 



 

 

 A dialog box is displayed showing the progress of the scanning process. You can click Stop button in the 

dialog box to stop the file scanning process. 

 

 

 

 Once the conversion process is complete, you can preview the converted mailbox. 

 
 

 

 

 

 

 



Preview Mailbox Items 

Once you select Apple mailbox and press 'Start' button, the software starts the process of conversion. 

After the process is finished, a preview of converted mailbox is generated in a three pane window. 

 

 

 

The left pane shows mail item folder as Mails, in a tree view. The middle pane displays the list of items in 

a single mail item folder and the right pane shows the content of selected individual item. To see the 

content of a mail item folder, simply click on it in the tree view. 

 

 
 

 

 

 

 



 

 

Save the Converted File 

 After the scanning of the mailbox you can save the converted file to .rge format. To save the file, follow 

the underlying steps: 

 

 Select the folder from the left pane of the preview window. Click on Save button on the tool bar to 

save the converted files. A destination folder dialog box is displayed. 

     Or,  

Alternatively, click on Save File option in the File Menu to perform the same task. 

 Select the destination path for saving the file. 

 A dialog box is displayed showing progress of the saving process. You can click Stop button in the 

dialog box to stop the file save process. 

 

 

 

 The converted file will be saved by the name 'Main Identity.rge'. A 'File Saved Successfully' dialog 

appears. 

 



 

 
 

 

 

 

 

 

 

 

 

 



 

 

Import Converted File in MS Outlook 2011 

Follow the underlying steps to import converted file into MS Outlook 2011 for Mac. 

 

1. Run MS Outlook application. 

2. On the File menu, select Import option. A new ’Import’ dialog is displayed. 

3. Select the 'Entourage information from an archive or earlier version' option and then click the 

'Right' arrow. 

4. Select ’Entourage archive (.rge)’ and then click the ’Right’ arrow. 

5. Select the converted file and click Import button. Import process is started. 

 
 

 

 

 

 

 

 

 

 

 

 

 



FAQs 

1. What does the Stellar Apple Mail to Outlook 2011 Converter do? 

 

Stellar Apple Mail to Outlook 2011 Converter can convert and save Apple Mail files to .rge files. 

Rge files can be opened in MS Outlook for Mac applications. 

 

2. What is the difference between Apple Mail and MS Outlook? 

 

Apple Mail and MS Outlook, both are used to access mails. Apple Mail has lesser features than MS 

Outlook. 

 

3. Is it necessary that MS Outlook be installed on the computer for conversion of files? 

 

No, MS Outlook is not necessary for running the conversion process. You can import the RGE file 

into MS Outlook 2011 to read the file.  

 

4. What are the steps to open a RGE file in MS Outlook? 

 

Follow the underlying steps to import .rge file into MS Outlook 2011 for Mac. 

 

1. Run MS Outlook application. 

2. On File menu, select Import option. A new ’Import’ dialog is displayed. 

3. Select the 'Entourage information from an archive or earlier version' option and then click the 

'Right' arrow. 

4. Select ’Entourage archive (.rge)’ and then click the ’Right’ arrow. 

5. Select the converted .rge file and click Import button. Import process is started. 

 
 

 

 

 

 



 

 

Legal Notices 

Copyright 

Stellar Apple Mail to Outlook 2011 Converter software, accompanied user guide and documentation are 

copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright 

laws, this user guide cannot be reproduced in any form without the prior written permission of Stellar 

Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use 

of the information contained herein. 

 

Copyright © Stellar Information Technology Private Limited. INDIA. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED., 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Apple Mail to Outlook 2011 Converter® is a registered trademark of Stellar Information 

Technology Private Limited. 

Mac OS X® is a registered trademark of Apple Inc.® 

MS Outlook® are registered trademark of Microsoft® Corporation Inc. 

Apple Mail® is a registered trademark of Apple Inc.® Corporation Inc.  

All Trademarks Acknowledged. 



All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

License Agreement 

Stellar Apple Mail to Outlook 2011 Converter 

Copyright © Stellar Information Technology Private Limited. INDIA. 

www.stellarinfo.com 

Stellar Apple Mail to Outlook 2011 Converter 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Apple Mail to Outlook 2011 Converter. 

 

Your Agreement to this License 

 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Apple Mail to Outlook 2011 Converter with which this License is included, you 

may return the complete package unused without requesting an activation key within 30 days after 

purchase for a full refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Apple Mail to Outlook 2011 Converter. For purposes of this License, if you have a valid single-user 

license, you have the right to use a single Licensed Copy of Stellar Apple Mail to Outlook 2011 Converter. 

If you or your organization has a valid multi-user license, then you or your organization has the right to 

use up to a number of Licensed Copies of Stellar Apple Mail to Outlook 2011 Converter equal to the 

number of copies indicated in the documents issued by Stellar when granting the license. 

 

Scope of License 

 

Each Licensed Copy of Stellar Apple Mail to Outlook 2011 Converter may either be used by a single 

person or used non-simultaneously by multiple people who use the software personally installed on a 

single workstation. This is not a concurrent use license. 

 

http://www.stellarinfo.com/


 

 

All rights of any kind in Stellar Apple Mail to Outlook 2011 Converter, which are not expressly granted in 

this license, are entirely and exclusively reserved to and by Stellar Information Technology Private 

Limited. You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create 

derivative works based on Stellar Apple Mail to Outlook 2011 Converter nor permit anyone else to do so. 

You may not make access to Stellar Apple Mail to Outlook 2011 Converter available to others in 

connection with a service bureau, application service provider or similar business nor permit anyone else 

to do so. 

 

Warranty Disclaimers and Liability Limitations 

 

Stellar Apple Mail to Outlook 2011 Converter and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar Apple Mail 

to Outlook 2011 Converter must be thoroughly tested with non-critical data before there is any reliance on 

it and you hereby assume the entire risk of all use of the copies of Stellar Apple Mail to Outlook 2011 

Converter covered by this License. This disclaimer of warranty constitutes an essential part of this 

License. In addition, in no event does Stellar authorize you or anyone else to use Stellar Apple Mail to 

Outlook 2011 Converter in applications or systems where its failure to perform can reasonably be 

expected to result in a significant physical injury or in loss of life. Any such use is entirely at your own risk 

and you agree to hold Stellar harmless from any and all claims or losses relating to such unauthorized 

use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

 

General 

 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 



of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

For more information about us, please visit www.stellarinfo.com 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/

